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Follow the precautions listed below to avoid permanent damage to the emulator.

I. Always use a grounding strap to prevent damage resulting from electrostatic discharge (ESD).

II. Power-Up Precautions.

1. Ensure that all power to the emulator and the target application (if any) is turned OFF.

2. Connect the target pod to the target application (if any).

http://www.zilog.com
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Follow the precautions listed below to avoid permanent damage to the emulator.

I. Always use a grounding strap to prevent damage resulting from electrostatic discharge (ESD).

II. Power-Up Precautions.

3. Ensure that all power to the emulator and the target application (if any) is turned OFF.

4. Connect the target pod to the target application (if any).

5. Power up the emulator, then press the RESET button.

6. Power up the target application (if any).

III Power-Down Precautions.

When powering down, follow this procedure in the precise order shown below:

1. Power down the target application board (if any).

2. Remove the target pod.

3. Power down the emulator.

 

NOTES:

 

1. Refer to the ÒPrecaution ListÓ section of the Product Information sheet for additional operating
precautions specific to various devices.

2. Do not leave the emulator powered up with the RS-232C cable connected to a powered-down PC.

3. Before inserting target pod into target application board, refer to Chapter 2 to determine appropriate
jumper selections and options.

Electrical Safeguards
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ABOUT THIS MANUAL

 

We recommend that you read and understand everything in this manual before setting up and 
using the product. However, we recognize that users have different styles of learning. There-
fore, we have designed this manual to be used either as a how-to procedural manual or a ref-
erence guide to important data.

The following conventions have been adopted to provide clarity and ease of use:

 

•

 

Universe Medium 10-point

 

 

 

all-caps is used to highlight to the following items:

–  commands , displayed messages

– menu selections, pop-up lists, button, fields, or dialog boxes 

– modes

– pins and ports

– program or application name

– instructions, registers, signals and subroutines

– an action performed by the software

– icons

 

•

 

 

 

Courier Regular 10-point

 

 is used to highlight the following items

– bit

– software code

– file names and paths

– hexadecimal value

 

•

 

Grouping of Actions Within A Procedure Step

Actions in a procedure step are all performed on the same window or dialog box.
Actions performed on different windows or dialog boxes appear in separate steps.





 

UM005100-IRR0400 vii

 

Chapter Title and Subsections Page

 

Z86L99 ICEBOX U

 

SER

 

’

 

S

 

 M

 

ANUAL

 

T

 

ABLE

 

 O

 

F

 

 C

 

ONTENTS

 

Chapter 1 
Introduction

 

O

 

VERVIEW

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1

E

 

MULATOR

 

 F

 

EATURES

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2
E

 

MULATOR

 

 L

 

IMITATIONS

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2

S

 

UPPORTED

 

 Z

 

I

 

LOG D

 

EVICES

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3

H

 

ARDWARE

 

 S

 

PECIFICATIONS

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3
O

 

PERATING

 

 C

 

ONDITIONS

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3
P

 

OWER

 

 R

 

EQUIREMENTS

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3
S

 

ERIAL

 

 I

 

NTERFACE

 

  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4

GUI-S

 

UPPORTED

 

 C

 

OMPILER

 

, A

 

SSEMBLER

 

 F

 

ORMATS

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4

K

 

IT

 

 C

 

ONTENTS

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4
A

 

DDITIONAL

 

 

 

ITEMS

 

 

 

NOT

 

 

 

SUPPLIED

 

  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4
O

 

PTIONAL

 

 R

 

ECOMMENDED

 

 I

 

TEM

 

  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-5

C

 

OMPUTER

 

 R

 

EQUIREMENTS

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-5
M

 

INIMUM

 

 R

 

EQUIREMENTS

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-5

C

 

ONTACTING

 

 Z

 

I

 

LOG C

 

USTOMER

 

 

 

SUPPORT

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-6



 

viii UM005100-IRR0400

 

Chapter Title and Subsections Page

 

Chapter 2 
Set-Up and Installation

 

H

 

ARDWARE

 

 I

 

NSTALLATION

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1
Q

 

UICK

 

 

 

INSTALLATION

 

 

 

INSTRUCTIONS

 

  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1
C

 

OMPLETE

 

 

 

INSTALLATION

 

 

 

INSTRUCTIONS

 

  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2

S

 

OFTWARE

 

 I

 

NSTALLATION

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8

E

 

MULATOR

 

 O

 

PERATION

 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8
R

 

ESETTING

 

  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8
LED O

 

PERATION

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-9
J

 

UMPER

 

 

 

SETTINGS

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-10
D

 

IP

 

 S

 

ETTINGS

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-12
P

 

ERFORMING

 

 OTP 

 

PROGRAMMING

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-14

 

Chapter 3 
Overview

 

E

 

MULATION

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-1

U

 

SING

 

 ZDS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
S

 

ELECT

 

 

 

THE

 

 E

 

MULATOR

 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
O

 

PEN

 

 

 

A

 

 

 

PROJECT

 

 

 

AND ADD FILES  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4

AVAILABLE DEBUG WINDOWS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7

Appendix A 
Troubleshooting Guide

INTRODUCTION . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .A-1

COUNTER JUMPS TO UNEXPECTED ADDRESS. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .A-2

ZDS ERROR MESSAGES . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .A-3
CAN NOT OPEN WINDOWS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .A-3
OUT OF SYNCHRONIZATION WITH THE EMULATOR  . . . . . . . . . . . . . . . . . . . . . . . . . . . .A-3

Appendix B 
Problem/Suggestion Report Form

Glossary

 Index



UM005100-IRR0400 ix

Table Page

Z86L99 ICEBOX USER’S MANUAL

LIST OF TABLES

TABLE 1-1 SUPPORTED PRODUCTS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3

TABLE 2-1 JUMPER SETTINGS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-10

TABLE 2-2 DIP SETTINGS TO DISABLE DIGITAL FUNCTIONS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-12

TABLE 2-3 DIP SETTINGS TO SET PULL-UP RESISTORS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-12

TABLE 3-1 DEBUG WINDOWS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7





UM005100-IRR0400 xi

Figure Page

Z86L99 ICEBOX  USER’S MANUAL

LIST OF FIGURES

FIGURE 2-1 EMULATOR CONNECTION . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-2

FIGURE 2-2 J6 JUMPER SCHEMATIC  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-3

FIGURE 2-3 Z86L9900100ZEM ICEBOX EXTERNAL TOP VIEW. . . . . . . . . . . . . . . . . . . . . . . . . . .  2-4

FIGURE 2-4 FRONT LED ASSIGNMENTS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-9

FIGURE 3-1 NEW PROJECT DIALOG BOX . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-2

FIGURE 3-2 EMULATOR CONFIGURATION DIALOG BOX . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-3

FIGURE 3-3 PROJECT VIEWER WINDOW. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-4

FIGURE 3-4 INSERT FILES INTO PROJECT DIALOG BOX . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-5

FIGURE 3-5 PROJECT VIEWER WINDOW WITH FILE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-5





UM005100-IRR0400 1–1

Z86L99 ICEBOX USER’S MANUAL

CHAPTER 1

INTRODUCTION

OVERVIEW

Congratulations for selecting a fine development tool! The Z86L9900100ZEM ICEBOX is 
ZiLOG’s in-circuit emulator providing emulation for the Z8 family of IR controllers. The 
emulator is also capable of OTP programming for the family being emulated. The emulator 
consists of an emulation daughter board that is plugged into a 64K motherboard via P1 and 
P2 headers. The Z86D99 ICE chip is used as the emulation processor on the daughter board. 

The motherboard provides host communication interface, control processor, I/O space 
decoding and LED indicators. The emulator is designed to be used with ZiLOG Developers 
Studio, giving the user a total package to write, edit and debug their applications.
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EMULATOR FEATURES

Key features of the Z86L9900100ZEM ICEBOX include:

• Supports up to 32K of ROM 

• Vary the operating voltage from 3.0-4.0V 

• Supports in-circuit emulation on target systems that operate from 3.0-4.0V

• The user can choose to power the ICE chip from either the emulator or target board

• Supports IR devices that operate up to 8MHz

• Emulates 28 and 40-pin DIP and 28-pin SOIC 

• OTP programming for 28 pin DIP and 28 pin SOIC, 40 pin DIP packages 

• Emulates and supports all the features and functions for a specified Z8 IR
microcontroller

• Multitasking allows the user to use other Windows applications while ZiLOG
Developer Studio (ZDS) is running

EMULATOR LIMITATIONS

The Z86D99 ICE chip’s ROM/ROMLESS pin is used to configure the ICE CHIP for 32K of 
internal ROM. This configuration affects the Z86L9900100ZEM ICEBOX in the following 
ways:

• Will not support emulation of a ROMLESS operation mode

• If the host software specifies that a device has between 4K to 32K of ROM the emulator
operates as if it is emulating a device with 32K of ROM 

To emulate pull-up transistors for their target board, you must manually set the emulator’s 
pull-up resistor dip switches. See page 2-12 for the proper settings of the emulator’s dip 
switches.

NOTE: Mask option pull-up resistance at 3V is about 200k Ohm +/-50% at room temperature. Lower 
voltage may cause an increase in resistance.
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SUPPORTED ZILOG DEVICES

Table 1-1 shows the products supported by the Z86L9900100ZEM ICEBOX:

HARDWARE SPECIFICATIONS

OPERATING CONDITIONS

Operating Humidity: 10%-90% RH (Non condensing)

Operating Temperature: 20°C ±10°C

Clocks: The control processor operates at 7.3728 Mhz, the 
emulation processor operates at 8Mhz 

Serial Baud Rate: 57,600 bps

POWER REQUIREMENTS

This emulator requires an external 5VDC power supply.

Operating Voltage (Input): +4.75 VDC to +5.25 VDC Max (+5.0 VDC typical) 

Operating Voltage (Target): +3.0 VDC to +4.0 VDC Max 

Operating Current: 0.8A typical 1.5A MAX

TABLE 1-1. SUPPORTED PRODUCTS

Packages Emulation OTP Required accessories

28 PDIP Z86L991PZ008SC Z86D991 
PZ008SC

28 PDIP emulation pod
28 PDIP program platform
(PC ASSY#99C0667-001) 

28 SOIC Z86L991SZ008SC Z86D991 
SZ008SC

28 PDIP emulation pod and a DIP to SOIC 
conversion adapter from Emulation 
Technology (AS-DIP 6-028-S003-1 or AS-DIP-6-
028-S003-2)
28 SOIC program platform
(PC ASSY#99C0668-001)

40 PDIP Z86L990PZ008SC Z86D990 
PZ008SC

40 PDIP emulation pod
40 PDIP program platform
(PC ASSY#990716-001) Rev. B

48 SSOP N/A Z86D990 
HZ008SC

Accessories for the 48 pin SSOP will be 
available the 4th quarter of 2000 
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SERIAL INTERFACE

ZiLOG Developer Studio communicates with theZ86L9900100ZEM ICEBOX using a 
DB25, RS-232 and DCE cable (TxD, RxD only).

GUI-SUPPORTED COMPILER, ASSEMBLER FORMATS

The Emulator supports object (binary or Intel hex) code files produced by ZiLOG Developer 
Studio (ZDS), ZiLOG Macro Cross Assembler (ZMASM).

KIT CONTENTS

The emulator kit contains one each of the following items:

• Z86L9900100ZEM ICEBOX

•  Z86D991 40 PDIP program platform ZiLOG PC: 99C0716-001 

• Z86D991 28 PDIP program platform ZiLOG PC: 99C0667-001

• Z86D991 28 SOIC program platform ZiLOG PC: 99C0668-001

• 40 PDIP emulation pod with cable ZiLOG PC: 99C0206-001

• 28 PDIP emulation pod with cable ZiLOG PC: 99C0217-001

• 5V Power Cable with banana plugs

• RS-232 Serial Cable, 9-pin M-F

• ZiLOG Developer Studio Installation CD

• Z86L99 ICEBOX User’s Manual

ADDITIONAL ITEMS NOT SUPPLIED

The following items are required but are not currently supplied in the emulator kit:

• A source of power (+5VDC typical) for the emulator. This can be a laboratory power
supply with current rating of at least 1.5 ampere.
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OPTIONAL RECOMMENDED ITEM

The following items are recommended:

• Your target design. Typically this is a wire-wrapped or printed circuit prototype that
includes a socket for the target device which the emulator cable/pod plugs into.

• Z8 C-Compiler 

• Oscilloscope

• Logic Analyzer

COMPUTER REQUIREMENTS

MINIMUM REQUIREMENTS

IBM PC (or 100-percent compatible) Pentium-Based Machine

75 MHz

16 MB RAM

VGA Video Adapter

Hard Disk Drive (12 MB free space)

CD-ROM Drive (a CD-ROM drive is not needed if you download ZDS from the web at 
www.zilog.com)

RS-232 COM Port

Mouse or Pointing Device

Microsoft Windows 95/98/NT

The following enhancements to the minimum requirements are recommended:

166MHz IBM PC

SVGA video adapter
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CONTACTING ZILOG CUSTOMER SUPPORT

ZILOG has a worldwide customer support center located in Austin, Texas. The customer 
support center is open from 7 a.m. to 7 p.m. Central Time.

The customer support toll-free number for the United States and Canada is 1-877-ZiLOGCS 
(1-877-945-6427). For calls outside of the United States and Canada dial 512-306-4169. The 
FAX number to the customer support center is 512-306-4072. Customers can also access 
customer support via the website at:

• For customer service - http://register.zilog.com/login.asp?login=servicelogin

• For technical support- http://register.zilog.com/login.asp?login=supportlogin

For valuable information about hardware and software development tools go to ZiLOG home 
page at http://www.zilog.com. The latest released version of the ZDS can be downloaded 
from this site.

http://register.zilog.com/login.asp?login=servicelogin
http://register.zilog.com/login.asp?login=supportlogin
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CHAPTER 2

SET-UP AND INSTALLATION

HARDWARE INSTALLATION

Before installing the hardware, refer to Figure 2-1 for a diagram on connecting the emulator 
to a PC and power supply; Figure 2-3 provides option jumper locations.

QUICK INSTALLATION INSTRUCTIONS

To install the hardware utilizing a 5VDC wall-adaptor power supply, perform the following. 

1. Set the correct jumper setting for powering the ICE chip and target board. See Emulator
connection on page 2-2.

2. Plug a 5.0 VDC 1.5 Amp Wall Power Adaptor to the power connector on the 
Z86L9900100ZEM ICEBOX.

3. Turn on the power supply and ensure that it is set to + 5.0V and current limited at 2.5A.

4. Connect the serial cable to the PC.

5. Connect the emulator to the target board (if performing in-circuit emulation).

6. Set up the oscillator and option jumpers.

7. Power up the Z86L9900100ZEM.
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COMPLETE INSTALLATION INSTRUCTIONS

The following procedures illustrate a complete step-by-step guide on installing the emulator.

FIGURE 2-1. EMULATOR CONNECTION

Set Power Jumper

The Z86L9900100ZEM ICEBOX allows the user to power the emulator and target from a 
variety of different sources. Before powering the emulator the user should select their power 
configuration.

CAUTION!

The user must choose their power source before powering the emulator. Before selecting a
power source study Figure 2-2, which shows a schematic of the J6 power jumper. Failure to
properly configure the power source will result in damage to the emulator or target. 

+-
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The user should choose from one of the below options when selecting their power source

• Jumper pin 1 to pin 3 and pin 2 to pin 4 to power both the ICE chip and target from the
emulator’s adjustable voltage regulator (default setting)

• Jumper pin 1 to pin 3 to power the ICE chip with the emulator’s adjustable regulator

• Jumper pin 2 to pin 4 to power target with the emulator’s adjustable regulator

• Jumper pin 3 to pin 4 to power the ICE chip from the target

CAUTION!

When powering the target from the emulator ensure that the target’s power supply is discon-
nected . 

FIGURE 2-2. J6 JUMPER SCHEMATIC

Target

Voltage Digital to Analog Converter

Emulator Adjustable 
Voltage Regulator

ICE chip

1 2

43

5 6

7 8
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FIGURE 2-3. Z86L9900100ZEM ICEBOX EXTERNAL TOP VIEW
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Connect the Power Supply

1. If the power supply provides voltage adjustment:

• Turn the power supply on and adjust it to +5V

• Adjust the setting adjustment for at least 2.5A, if there is a current-limiting adjustment.

2. Turn the power supply off.

3. Locate the power cable (red wire, black wire, and banana plugs on the other end). Plug in 
the black banana plug into the black jack on the power supply (labeled COM, GND, or with 
the ground symbol). Plug the red plug into the red jack on the power supply (labeled +, +V 
or +5V).

4. Plug the white connector on the other end of the cable into the matching 4-pin connector 
on the back side of the emulator. (This connection is keyed to ensure against an improper 
connection.)

NOTE: The ZiLOG Power Supply Accessory Kit (ZPS05V00ZAC), which is sold separately, provides 
a fixed-5V Universal Output Power Supply, accepts 110V to 220V AC input, and includes a power 
cable and an in-line jack cable.

CAUTION!

Always check the supply voltage before plugging in the power cord.

Connect the Serial Cable to the PC

Locate the serial cable. Connect the male end to the female connector on the back of the ICE-
BOX, and the female end to either the COM1, COM2, COM3, or COM4 connector of the 
host PC.

NOTE: If connector availability is limited to a 9-pin COM1 through COM4, then use either a different 
cable or a 25-pin to 9-pin converter. (Available at any electronics store for a nominal fee.)
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Connect to the Design

Connect to the target design by performing the following steps:

1. Locate the emulation cable for the device.

CAUTION!

Wear a properly grounded wrist strap or similar ESD protection before continuing.

2. Plug the cable into the target device. Ensure that the pin 1 marking (as indicated by the red 
mark on the ribbon cable) matches pin 1 on the target board. 

3. Plug the other end of the cables into target pod on top of the emulator. See Figure 2-3 for 
the location of the target pod.

4. Select the power source for the Z86D99 ICE chip by configuring the J6 jumper. See 
Table 2-2 for more information on jumper settings and Figure 2-3 for the location of the J6 
jumper.

5. Select either the supplied 8MHz oscillator or the target’s oscillator to clock the ICE chip. 
See Jumper settings on page 2-10 for more information on how to configure the emulator 
to use the target boards oscillator.

CAUTION!

The user can not run the emulator’s oscillator if the target oscillator or XTAL is connected. At
this time use one of the following methods to set the ICE-chip’s clock:

• To use the emulators oscillator remove the target’s oscillator and connect pin 2 to
pin 3 on the J5 jumper

• To Use the target’s oscillator and connect pin 1 to pin 2 on the J5 jumper and remove
the ICEBOX’s 8 MHz oscillator located at Y1.
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Adjust the voltage

If the emulator is powered by its adjustable regulator then the voltage must be manually set. 
Set the emulator voltage by performing the following steps: 

CAUTION!

If the target and emulator are using separate power supplies then the ICE chip voltage must be
adjusted to match the target’s device voltage. Failure to match the target devices voltage with
the ICE chip’s voltage could result in damage to the emulator, target device or ICE chip.

1. Locate the voltage adjuster on top of the emulator. See Figure 2-3 for the location of the
voltage adjuster.

2. Attach the voltmeter lead to either pin 1 or pin 2 on the J6 jumper and ground.

3. Apply power to the emulator with the target device disconnected.

4. Turn the voltage adjuster’s screw until the voltmeter read-out matches the target device 
output voltage.

Connect Logic Analyzer (Optional)

The logic analyzer can either be connected as part of the initial setup, or later as the user con-
tinues working with their design. 

Connect to a logic analyzer by performing the following steps:

1. Locate the cable for the logic analyzer.

NOTE: Wear a properly grounded wrist strap or similar ESD protection before continuing.

2. Plug the logic analyzer into the ZiLOG logic analyzer adapter (sold separately from the 
Z86L9900100ZEM ICEBOX kit).

NOTE: The logic analyzer adapter can be ordered from customer support by requesting part number 
98C0289-001.

3. Plug the cable from the ZiLOG logic analyzer adapter into the emulator. Ensure that the pin 
1 marking (as indicated by the red mark on the ribbon cable) matches the pin 1 on the target 
board. See Figure 2-3 for the location of the logic analyzer connector.
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Power the Emulator

If anything unusual (such as an unexpected sound and/or smell occurs when turning on the 
power supply, turn off the power supply and check the setting for the J6 jumper. See Emula-
tor connection on page 2-2. If the power supply allows voltage adjustment, adjust it again to 
+5V. (It may be somewhat lower than +5V because of the emulator load. 

After power-up, press the RESET button to reset the ICE chip. (Pressing the RESET button 
avoids bus contention on the I/O lines.) If the emulator is not powering your design through 
the VCC pin, turn on the power supply of the design.

CAUTION!

If your design already has a power supply, do not power your design from the emulator VCC pin.

When powering down, follow the procedure described below:

1. Power down the target application board (if using the target power supply).

2. Power down the emulator.

NOTE: Refer to the complete Electrical Safeguards information shown on the inside cover of this man-
ual.

SOFTWARE INSTALLATION

For more information on installing ZDS refer to the user manual PDF that is included on the 
installation CD-ROM or download ZDS literature from the ZiLOG web page at zilog.com.

EMULATOR OPERATION

The following topics guide the user on how to operate the emulator and configure jumper set-
tings.

RESETTING

Press the RESET button on the emulator to reset the state of the target device and the status 
that was established using ZDS. 

For example, the emulator sets the program counter to %000C.

After reset, wait until the Ready LED is ON and has finished blinking before starting ZDS. 
Refer to the LED Operation section of this chapter for more details.

NOTE: Always press the RESET button on the emulator before starting ZDS.
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LED OPERATION 

ZiLOG emulators use LEDs to communicate the different hardware states. The following 
table gives a description of the LEDs. The Z86L9900100ZEM LED’s are located on the right 
front of the emulator.

FIGURE 2-4. FRONT LED ASSIGNMENTS

LED Indication Description

READY On
Off

Communicating in Bisync Mode and waiting for command
Communicating in ASCII Mode or executing Bisync command

RUN On
Off

Running user code
Not running user code

OTP On
Off

The Emulator is performing OTP programing
The Emulator is not performing OTP programming

PWR On
Off
Blink

Emulator is powered up and Self Test is completed
Power is off
Emulator is self-testing
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JUMPER SETTINGS 

The following table lists jumper setting that the are easily configured by the user. See 
Figure 2-3 for the jumper locations.

TABLE 2-1. JUMPER SETTINGS  

Jumper Pin Position Description

J1 N/A Out (Default) OTP programming adapter pins

J2 N/A Out (Default) OTP programming adapter pins

J3 1-2 Out (Default) Reserved for data memory (do not use)

J4 1-2 Out (Default) Reserved for external memory (do not use)

J6 1-3 In (Default) ICE chip is powered by the emulator’s adjustable 
regulator

J6 2-4 In (Default) Target is powered by emulator’s adjustable 
regulator

J6 5-7 In ICE chip is powered by a programmable regulator 
(The programmable regulator is currently not 
supported . Contact ZiLOG customer support to see if 
the programmable regulator has been released .)

J6 4-6 In Target is not powered by emulator (See Emulator 
connection on page 2-2 for more information)

J7 N/A Open (Default) Do not Jumper, jumping these pins will short port 
4 pin 3 VCC! These two pins are used as a 
connector for the port 4 pin 3 IR LED. 

J8 1-2 In (Default) Connects Ports 4 pin 3 to target

J8 1-2 Out Disconnects ports 4 pin 3 from target

JP1 1-2 In Disable Vbo

JP1 1-2 Out (Default) Enable Vbo

JP2 1-2 In (Default) AVDD to VDD core

JP2 1-2 Out Target board will supply power to AVDD (a 40 pin 
part is being emulated)

JP3 1-2 In A 28 pin part is being emulated

JP3 1-2 Out (Default) VCC_I isolates from AVDD (use internal filter)

JP4 1-2 In (Default) Cap’s to AVDD 

JP4 1-2 Out N/A
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NOTE: The user can not run the emulator’s oscillator if the target oscillator or XTAL is connected. At 
this time use one of the following methods to set the ICE-chip’s clock:

• To use the emulators oscillator remove the target’s oscillator and connect pin 2 to pin 3 on
the J5 jumper

• To use the target’s oscillator and connect pin 1 to pin 2 on the J5 jumper

Setting Jumpers for Targets

For all targets ensure that JP2 and JP4 are always connected. For 40 pin targets also connect 
JP3.

 

JP5 1-2 In ICE chip uses target oscillator/clock (see Note at the 
bottom of the table)

JP5 2-3 In * (Default) ICE chip uses emulator oscillator/clock (see Note at 
the bottom of the table)

TABLE 2-1. JUMPER SETTINGS (CONTINUED)

Jumper Pin Position Description

J1 N/A Out (Default) OTP programming adapter pins
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DIP SETTINGS

DIP switch banks S1 and S3 are used to disable digital functions for ports 1 and 3. DIP 
switch banks S2, S4, S5 and S6 are used to emulate port pin pull-up transistors for the Ice 
Chip. See Figure 2-3 for the location of the DIP switches. The following tables list DIP set-
tings that are easily configured by the user.

TABLE 2-2. DIP SETTINGS TO DISABLE DIGITAL FUNCTIONS

DIP bank Switch Description

S1 1 Turn off to disable digital functions for Port 5 Pin 0 

S1 2 Turn off to disable digital functions for Port 5 Pin 1 

S1 3 Turn off to disable digital functions for Port 5 Pin 2 

S1 4 Turn off to disable digital functions for Port 5 Pin 3 

S1 5 Turn off to disable digital functions for Port 4 Pin 4

S1 6 Turn off to disable digital functions for Port 4 Pin 5

S1 7 Turn off to disable digital functions for Port 4 Pin 6

S1 8 Turn off to disable digital functions for Port 4 Pin 7

TABLE 2-3. DIP SETTINGS TO SET PULL-UP RESISTORS  

DIP bank Switch Description

S2 1 Turn on to set a pull-up resistor for Port 2 Pin 0

S2 2 Turn on to set a pull-up resistor for Port 2 Pin 1

S2 3 Turn on to set a pull-up resistor for Port 2 Pin 2

S2 4 Turn on to set a pull-up resistor for Port 2 Pin 3

S2 5 Turn on to set a pull-up resistor for Port 2 Pin 4

S2 6 Turn on to set a pull-up resistor for Port 2 Pin 5

S2 7 Turn on to set a pull-up resistor for Port 2 Pin 6

S2 8 Turn on to set a pull-up resistor for Port 2 Pin 7

S4 1 Turn on to set a pull-up resistor for Port 5 Pin 0

S4 2 Turn on to set a pull-up resistor for Port 5 Pin 1

S4 3 Turn on to set a pull-up resistor for Port 5 Pin 2

S4 4 Turn on to set a pull-up resistor for Port 5 Pin 3

S4 5 Turn on to set a pull-up resistor for Port 5 Pin 4
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NOTE: Mask option pull-up resistance at 3V is about 200k Ohm +/-50% at room temperature. Lower 
voltage may cause an increase in resistance.

S4 6 Turn on to set a pull-up resistor for Port 5 Pin 5

S4 7 Turn on to set a pull-up resistor for Port 5 Pin 6

S4 8 Turn on to set a pull-up resistor for Port 5 Pin 7

S5 1 Turn on to set a pull-up resistor for Port 6 Pin 0

S5 2 Turn on to set a pull-up resistor for Port 6 Pin 1

S5 3 Turn on to set a pull-up resistor for Port 6 Pin 2

S5 4 Turn on to set a pull-up resistor for Port 6 Pin 3

S5 5 Turn on to set a pull-up resistor for Port 6 Pin 4

S5 6 Turn on to set a pull-up resistor for Port 6 Pin 5

S5 7 Turn on to set a pull-up resistor for Port 6 Pin 6

S5 8 Turn on to set a pull-up resistor for Port 6 Pin 7

S6 1 Turn on to set a pull-up resistor for Port 4 Pin 0

S6 2 Turn on to set a pull-up resistor for Port 4 Pin 1

S6 3 Turn on to set a pull-up resistor for Port 4 Pin 2

S6 4 Turn on to set a pull-up resistor for Port 4 Pin 3

S6 5 Turn on to set a pull-up resistor for Port 4 Pin 4

S6 6 Turn on to set a pull-up resistor for Port 4 Pin 5

S6 7 Turn on to set a pull-up resistor for Port 4 Pin 6

S6 8 Turn on to set a pull-up resistor for Port 4 Pin 7

TABLE 2-3. DIP SETTINGS TO SET PULL-UP RESISTORS (CONTINUED)

DIP bank Switch Description



PERFORMING OTP PROGRAMMING

The Z86L9900100ZEM ICEBOX is designed for OTP programming. To perform OTP pro-
gramming perform the following steps:

1. Locate the supplied OTP adapter for the micro controller you wish to program. Consult
Table 1-1for the proper OTP adapter.

2. Insert the OTP adapter into the emulator’s OTP Programming socket (J1 and J2), see 
Figure 2-3.

3. Place the micro controller into the OTP programing adapter. 

4. If the adapter is equipped with a ziff socket, ensure that the ZIF socket locking lever is in 
the down (closed) position.

5. Perform OTP programing. Consult the ZDS user manual for more information on OTP 
programing.

6. Pull straight up on the micro controller to remove it from the OTP programing adapter. 

NOTE: Be careful not to bend the micro controller’s pins when removing it from the OTP adapter.
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CHAPTER 3

OVERVIEW

EMULATION

The Z86L9900100ZEM ICEBOX uses the Z86D99 ICE chip to provide emulation for the Z8 
family of IR controllers. The emulator is capable of OTP programming for the family being 
emulated. The user can manually set pull-up resistors and adjust the voltage of the ICE chip 
to match the target’s voltage. 
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USING ZDS

This emulator is fully compatible with ZiLOG Developer Studio (ZDS) software. The fol-
lowing steps briefly describe the procedures necessary to setup and create projects with the 
Z86L9900100ZEM emulator. A summary of the emulator’s available debug windows is also 
included at the end of this chapter.

For more detailed information on using ZDS, refer to the ZDS User Manual (in PDF format) 
located on the installation CD-ROM, or download the latest information from our web site at 
www.zilog.com.

SELECT THE EMULATOR

To select the emulator and create a new project, perform the following steps:

1. Open ZDS by selecting Start>Programs>Zilog Developer Studio> ZDS.

2. Choose New Project from the File menu. The New Project dialog box appears. 

NOTE: If the project has already been created, select Target from the Project menu and perform the 
following steps for the ZiLOG MCU Database dialog box. See Figure 3-1.

FIGURE 3-1. NEW PROJECT DIALOG BOX

3. Select Application  in the Selection by field.

4. Select IR Remote  from the Master pop-up list.

5. Select a microcontroller from the IR Remote family in the Project Target pop-up list.

6. Select Z86L9900100ZEM  in the Emulator pop-up list. 
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7. Click on the browse button (...) in the Project Name field. The New Project Browse 
dialog box appears. 

8. Enter the project file name  and select a path in the New Project Browse dialog box.

NOTE: All build output files, such as linker and assembly files are saved in the same directory as the 
project.  

9. Click Save. The project name appears in the Project Name field in the New Project dialog 
box.

10. Click on Chip Data to view the micro controller specifications. 

NOTE: Fields in the Chip Data page are read-only and can’t be modified.

11. Click OK. The new project is saved as the name specified in the New Project Browse 
dialog box.

12. Select Emulator Configuration from the Project menu. The Emulator Configuration 
dialog box appears. See Figure 3-2.

FIGURE 3-2. EMULATOR CONFIGURATION DIALOG BOX

13. Ensure that Emulator is selected in the Module field. 

14. Select the port the emulator is connected to from the Port pop-up list.

15. Select 57600  from the Baud Rate pop-up list.

16. Click OK to close and apply the Emulator Configuration options.

17. Select Save Project from the File menu to save the emulator configuration setting. 
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OPEN A PROJECT AND ADD FILES

A previously created project has the following attributes saved with it:

• Target settings

• Assembler and Linker settings for the specified target

• Source files (including header files)

NOTE: Use the Project Viewer window to view and access the various files in any given project.

Perform the following steps to open a previously created project:

1.  Select Open Project from the File menu. The Open Project dialog box appears. 

2. In the Open Project dialog box, select the previously created project. The project appears 
in the Project Viewer window. See Figure 3-3.

FIGURE 3-3. PROJECT VIEWER WINDOW

Add an existing file

Perform the following steps to add an existing file to a project:

1. Select Add to Project>Files from the Project menu. The Insert Files into Project dialog
box appears. See Figure 3-4.
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FIGURE 3-4. INSERT FILES INTO PROJECT DIALOG BOX

2. Select the file to add to the project. 

3. Click Open. The file appears in the Project Viewer window. See Figure 3-5.

FIGURE 3-5. PROJECT VIEWER WINDOW WITH FILE

4. Double-click on the file in the Project Viewer window. The file appears in the ZDS main 
Edit window.

NOTE: In some cases, non-editable files, such as .obj files need to be included in a project. 
These files will be displayed in the source file list, but cannot be opened. When the project is built, 
these files are automatically linked.

5. Select Update All Dependencies from the Build menu. The Dependencies folder list 
in the Project Viewer window is updated.
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Add a new file

1. Select Add to Project>New from the Project menu. The Insert New Files Into
Project dialog box appears.

2. Type a file name in the File Name field. 

3. Click Open. The new file name appears in the Project Viewer window with a .asm  
suffix, and a blank Edit window also appears.

NOTE:  Header and Included files do not have to be added. The program detects those called by the 
source code.
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AVAILABLE DEBUG WINDOWS

The following table lists the debug windows that are available using ZDS.

TABLE 3-1. DEBUG WINDOWS      

Window Function            (Updated values will display in red)

Watch • Shows the symbols and the contents of the registers (see the
ZDS user manual for more information)

Z8 Standard 
Registers

• Shows the contents of the Z8 standard registers 

Code Memory • Allows the user to monitor, edit, and download a file.ld  or
file.hex  into the Code Memory from generated assembly
source code 

• Tracks a specific address entered in the Code Address edit box

Disassembly • Shows code memory along with the corresponding
disassembled code 

• Allows the user to edit, and download a file.ld or file.hex into
the Code memory   

• Follows the program counter 

• Provides a complete scroll down with this window, however
the scroll up is limited

• Accesses the disassembly of code at the address specified in
the Code Address field 

• The Disassembly window is automatically displayed when
debugging hex code or whenever there is no corresponding
source file available at the address specified by the program
counter

Z8 Register File • Shows all Z8 internal and external registers, all RAM pointer
and data registers, status registers and status flags, and stacks 

• Monitor and edit write-able registers in this window

Z8 Expanded 
Register

• Displays the Z8 Expanded Register banks that are specified in
the configuration 

• Monitor and edit write-able registers directly in this window by
selecting a specific bank tab 

Working Registers • Modify and view working registers in this window
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Timer Counter 
Registers 

• Modify the timer/counter registers in this window

Ports Register • Monitor and edit port registers in this window 

Internal Data 
Memory

• Display address from FF00 to FFFF

TABLE 3-1. DEBUG WINDOWS (CONTINUED)    

Window Function            (Updated values will display in red)
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APPENDIX A
TROUBLESHOOTING GUIDE

INTRODUCTION

Before contacting a ZiLOG representative or submitting a Problem Report, please follow 
these simple steps. Also, check the Precautions and Limitations sections in the Product Infor-
mation document included with the emulator to eliminate other possible known problems. If 
a hardware failure is suspected, contact a local ZiLOG representative for assistance.

If the initial ZiLOG screen is not appearing after selecting the COM port and the screen mes-
sage displays Time-out while reading:

1. Check the RS-232C cable connection and communication port selection in ZDS. See Select
the Emulator on page 3-2 for more information on how to configure the host PC’s port.

2. Reset the emulator and ZDS. 

3. If you are using the emulator’s oscillator, ensure that you removed the target’s oscillator 
and connected pin 2 to pin 3 on the J5 jumper.

4. If ICEBOX stops working after connecting to the target, check whether the target crystal is 
removed while using the ICEBOX’s oscillator.

5. Try connecting another cable.

6. Check if transmit/receive signals need to be swapped.

NOTE: On some DB9 connectors for the COM ports, the transmit/receive signal may be swapped and 
a Null Modem adapter may be required.

7. Ensure that the power supply is connected, is turned on, and power is available.

8. Ensure that the power supply is set at +4.75 VDC to +5.25 VDC Max (+5.0 VDC typical).

9. Ensure that the J6 power jumper has been properly configured. See Emulator connection 
on page 2-2 for more information on setting the J6 jumper.

10. Check if power supply is supplying the required current (0.8A typical) to the emulator.
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11. Check P42 pin. If P42 stays low check the target pod and ensure that it is not shorting to 
ground. If it is shorted, ensure that you are using the proper emulation pod, see Table 1-1.

12. After resetting the emulator, wait a minimum of 5 seconds before running ZDS.

13. If P42 always shows low, check the 40-pin target pod’s pin 31. 

NOTE: The previous Z86L71 and Z86L98 ICEBOX 40 pin target pod have pin 31 connecting to 
ground for emulating the L73/87/89. That target pod can not be used for Z86L990 emulation. Only use 
the target cable which is shipped with the Z86L99 ICEBOX.

COUNTER JUMPS TO UNEXPECTED ADDRESS

Any instruction other than a DI  instruction is used to disable interrupts. Possible causes 
include:

• The stack overflows into the general register locations.

• Extra POP, PUSH, IRET , or RET is encountered (stack unbalanced).

• Program resets repeatedly.

– Program counter rolls over from value FFFF to 0000 and proceeds back to the
beginning of program.

– Watch-Dog Timer (WDT) is not initialized or refreshed.

• Unintialized interrupt vector is activated. The interrupt vector is not set to the interrupt
handler.
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ZDS ERROR MESSAGES

CAN NOT OPEN WINDOWS 

If this message appears while attempting to open a window in ZDS, there may be too many 
applications running. Try closing the other active applications or exit and restart your PC.

OUT OF SYNCHRONIZATION WITH THE EMULATOR

This message appears whenever communication between the emulator and the PC is inter-
rupted.

1. Ensure that the power cable is connected.

2. Ensure that the RS-232C cable is connected.

3. Change the baud rate setting (default is 19200 ). A lower setting usually improves 
communications reliability. 

4. Reestablish communication between ZDS and the emulator. See the ZDS user manual for 
more information establishing communication with an emulator.
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APPENDIX B
PROBLEM/SUGGESTION REPORT FORM

If you experience any problems while operating this product, or if you note any inaccuracies 
while reading the User's Manual, please copy this form, fill it out, then mail or fax it to 
ZiLOG. We also welcome your suggestions!

Customer Information

Product Information and Return Information

Problem Description or Suggestion

Provide a complete description of the problem or your suggestion. If you are reporting a 
specific problem, include all steps leading up to the occurrence of the problem. Attach 
additional pages as necessary.
______________________________________________________________________________________

______________________________________________________________________________________

______________________________________________________________________________________

Name Country

Company Telephone

Address Fax Number

City/State/ZIP E-Mail Address

Serial # or Board Fab #/Rev. # ZiLOG , Inc.

Software Version System Test/Customer Support

Manual Number 910 E. Hamilton Ave., Suite 110, MS 4-3

Host Computer Description/Type Campbell, CA 95008

Fax Number: (408) 558-8536

Email: tools@zilog.com
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Address Space Physical or logical area of the target systemÕs
Memory Map. The memory map could be physically
partitioned into ROM to store code, and RAM for data.
The memory can also be divided logically to form sepa-
rate areas for code and data storage.

ANSI American National Standards Institute.

ASCII American Standard Code of Information Interchange.

ASM Assembler File.

ASYNC Asynchronous Communication Protocol.

ATM Asynchronous Transfer Mode.

B Binary.

Baud Unit of measure of transmission capacity. 

Binary Number system based on 2. A binary digit is a bit.

BISYNC Bidirectional Synchronous Communication Protocol.

Bisynchronous 
Communications A protocol for communications data transfer used

extensive in mainframe computer networks. The
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sending and receiving computers synchronize their
clocks before data transfer may begin.

Bit A digit of a binary system. It has only two possible 
values: 0 or 1.

BPS Bits Per Second. Number of binary digits transmitted
every second during a data-transfer procedure.

Buffer Storage Area in Memory. 

Bug A defect or unexpected characteristic or event.

Bus In Electronics, a parallel interconnection of the internal
units of a system that enables data transfer and
control Information.

Byte A collection of four sequential bits of memory. Two
sequential bytes (8 bits) comprise one word.

CALL This command invokes a subroutine

Checksum A field of one or more bytes appended to a block of n
words which contains a truncated binary sum formed
from the contents of that block. The sum is used to
verify the integrity of data in a ROM or on a tape.

COM Device name used to designate a communication
port.
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Control Section A continuous logical area containing code or user 
data. Each control section has a name. The linker puts
all those control sections with the same name in one
entity. The linker provides address spaces to the
control sections. There are either absolute control
sections or relocatable ones.

CPU Central Processing Unit.

Cross-Linkage Editor A linkage editor that executes on a processor that is not
the same as the target processor.

DSP Digital Signal Processing. A specialized micropro-
cessor that is tailored to perform high repetition math 
processing and improve signal quality.

Emulator An emulation device. For example, an In-Circuit 
Emulator (ICE) module duplicates the behavior of the 
chip it emulates in the circuit being tested.

External Symbol A symbol that is referenced in the current program file
but is defined in another program file.

GUI Graphical User Interface. The windows and text that a 
user sees on their computer screen when they are 
using a program.

H Hexadecimal, Half-Carry Flag.

Hex Hexadecimal.

Hexadecimal A Base-16 Number System. Hex values are often
substituted for harder to read binary numbers.

ICE In-Circuit Emulator. A ZiLOG product which supports
the application design process.

IE Interrupt Enable.
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IM Immediate Data Addressing Mode.

IMASK Interrupt Mask Register.

IMR Interrupt Mask Register.

INC Increment.

INCW Increment Word.

Initialize To establish start-up parameters, typically involving 
clearing all of some part of the deviceÕs memory space.

Instruction Command.

INT Interrupt.

Internal Symbol A symbol that is defined in a program file. This symbol
could be visible to multiple functions within the same
program file.

I/O Input/Output. In computers, the part of the system that
deals with interfacing to external devices for input or
output, such as keyboards or printers.

IPR Interrupt Priority Register.

Ir Indirect Working-Register Pair Only.

IR Infrared. A light frequency range just below that of
visible light.

IRQ Interrupt Request.

ISDN Integrated Services Digital Network.

ISO International Standards Organization.
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JP Jump.

JR Jump Relative.

Library A File Created by a Librarian. This file contains a
collection of object modules that were created by an
assembler or directly by a C compiler.

Local Symbol Symbol visible only to a particular function within a 
program file.

LSB Least Significant Bit.

MCU Microcontroller or Microcomputer Unit. 

MI Minus.

MLD Multiply and Load.

MPYA Multiply and ADD.

MPYS Multiply and Subtract.

MSB Most Significant Bit.

Nibble A Group of 4 Bits.

NMI Non-Maskable Interrupt.

NOP No Operation.

Object Module Programming code created by assembling a file with
an assembler or compiling a file with a compiler.
These are relocatable object modules and are input to
the linker in order to produce an executable file.

OMF Object Module Format.
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OPC Operation Code.

Op Code Operation Code.

OTP One-Time Programmable.

PCON Port configuration register.

PER Peripheral. A device which supports the import or
output of information.

POP Retrieve a Value from the Stack.

POR Power-On Reset.

Port The point at which a communications circuit termi-
nates at a Network, Serial, or Parallel Interface card.

PRE Prescaler.

PROM Programmable Read-Only Memory.

Protocol Formal set of communications procedures governing
the format and control between two communications 
devices. A protocol determines the type of error 
checking to be used, the data compression method, if 
any, how the sending device will indicate that it has 
finished sending a message, and how the receiving 
device will indicate that it has received a message. 

PRT Programmable Reload Timer or Print.

PTR Pointer.

PTT Post, Telephone, and Telegraph. Agency in many 
countries that is responsible for providing telecommu-
nication approvals. 
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Public/Global Symbol A programming variable that is available to more than
one program file.

PUSH Store a Value In the Stack.

r Working Register Address.

R Register or Working-Register Address, Rising Edge.

RA Relative Address.

RAM Random-Access Memory. A memory that can be 
written to or read at random. The device is usually 
volatile, which means the data is lost without power.

RC Resistance/Capacitance.

RD Read.

RES Reset.

Resolution In a digital image, the total number of pixels in the 
horizontal and vertical directions.

RFSH Refresh.

ROM Read-Only Memory. Nonvolatile memory that stores
permanent programs. ROM usually consists of 
solid-state chips.

ROMCS ROM Chip Select.

RP Register Pointer.

RR Read Register or Rotate Right.

SCF Set C Flag.
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SIO Serial Input/Output.

SL Shift Left or Special Lot.

SLL Shift Left Logical.

SMR Stop Mode Recovery.

SN Serial Number.

SOIC Small Outline IC.

SP Stack Pointer.

SPH Stack Pointer High.

SPI Serial Peripheral Interface.

SPL Stack Pointer Low.

SRAM Static Random Access Memory.

SR Shift Right.

SRA Shift Right Arithmetic.

SRC Source.

SSI Small Scale Integration. Chip that contains 5 to 50 
gates or transistors.

Static Characteristic of Random Access Memory that 
enables It to operate without clocking signals.

ST Status.

STKPTR Stack Pointer.
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SUB Subtract.

SVGA Super Video Graphics Adapter.

S/W Software.

SWI Software Interrupt.

Symbol Definition Symbol defined when the symbol name is associ-
ated with a certain amount of memory space,
depending on the type of the symbol and the size of 
Its dimension.

Symbol Reference Symbol referenced within a program flow, when-
ever It is accessed for a read, write, or execute 
operation.

SYNC Synchronous Communication Protocol. An event or 
device is synchronized with the CPU or other process 
timing.

TC Time Constant.

TCM Trellis Coded Modulation.

TCR Timer Control Register.

TMR Timer Mode Register.

UART Universal Asynchronous Receiver Transmitter.
Component or functional block that handles asynchro-
nous communications. Converts the data from the 
parallel format in which it is stored, to the serial format 
for transmission.

UGE Unsigned Greater Than or Equal.

UGT Unsigned Greater Than.
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ULE Unsigned Less Than or Equal.

ULT Unsigned Less Than.

UM UserÕs Manual.

USART Universal Synchronous/Asynchronous
Receiver/Transmitter. Can handle synchronous as well 
as asynchronous transmissions.

USB Universal Serial Bus.

USC Universal Serial Controller.

UTB Use Test Box. A board or system to test a particular 
chip in an end-use application.

V Volt, Overflow Flag.

VCC Supply Voltage.

VDD Voltage from the Digital Power Supply.

VPP Programmed Voltage.

VRAM Video Random-Access Memory. A special form of
RAM chip that has a separate serial-output port for 
display refresh operations. This architecture speeds up
video adaptor performance.

VREF Analog Reference Voltage.

WDT Watch-Dog Timer. A timer that, when enabled under
normal operating conditions, must be reset within the
time period set within the application (WDTMR (1,0)). If
the timer is not reset, a Power-on Reset occurs. Some 
earlier manuals refer to this timer as the WDTMR.
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WDTOUT Watch-Dog Timer Output.

Word Amount of data a processor can hold in its registers 
and process at one time. A DSP word is often 16 bits. 
Given the same clock rate, a 16-bit controller 
processes four bytes in the same time it takes an 8-bit 
controller to process two.

WR Write.

WS Wafer Sort.

X Indexed Address, Undefined.

XOR Bitwise Exclusive OR.

XTAL Crystal.

Z Zero, Zero Flag.

ZASM ZiLOG Assembler. ZiLOGÕs program development
environment for DOS.

ZDS ZiLOG Developer Studio. ZiLOGÕs program develop-
ment environment for Windows 95/98/NT.

ZEM ZiLOG Emulator.

ZiLOG Symbol Format Three fields per symbol including a string containing 
the Symbol Name, a Symbol Attribute, and an Absolute 
Value in Hexadecimal.

ZLD ZiLOG Linkage Editor. Cross linkage editor for ZiLOGÕs
microcontrollers.

ZLIB ZiLOG Librarian. Librarian for creating library files from
locatable object modules for the ZiLOG family of
microcontrollers.
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ZMASM ZiLOG Macro Cross Assembler. 

ZDS ZiLOGÕs program development environment for 
Windows 3.1 and up.

ZOMF ZiLOGÕs Object Module Format. The object module
format used by the linkage editor.
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nAD_I_OEpg11
nRST_Itvpg4,11

A_M_LO[1..0]pg9
P_RD_WRpg10

P_CLK_CE pg7,8,10
P_WR_RD pg7,8,10
nDS_frI pg8
nP_PGM pg7,10
P_CLR pg7,10
P_CLK pg7,10

R_W_M pg8
AD_M[7..0] pg8

nAS_M pg8
C_DR_ADI pg8
nRST_frM pg8

nDS_M pg8
nRST_CT pg8
P_CT_CLK pg8

nSYNCpg11

nMDS_Ipg11

SCLKpg11

nMAS_Ipg11
R_W_Ipg11

P34_nDMpg11

nDS_Ipg11

nAS_Ipg11

nRST_Tpg11

R32_64pg7
nEXR_OFFpg7

C_JAM_P1pg8
FG_BGpg8

nDR_P1MM

P_TBD2pg7,10
P_TBD1pg7,10

A_M[15..8] pg8

nDMpg8

nRST_frIpg11

P_TBD3pg7,10
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A

A

B

B

C

C

D

D

E

E

4 4

3 3

2 2

1 1

(L99 PORT4)

(L99 PORT6)

(L99 PORT2)

(L99 PORT5)

L99 IC E MCU

USER NOTE:
SELECT CLOCK SOURCE FOR ICE MCU ON DAUGHTER BOARD.
JUMPER PIN 1 & 2 => CLOCK FOR DAUGHTER BOA RD ICE MCU TO COME FROM
TARGET SY STEM.
JUMPER PIN 2 & 3 => DAUGHTER BOARD I CE MCU WILL USES OSCILLATOR
RESIDING ON DAUG HTER BOARD.

USER NOTE:
INSTALL JP2 AND JP3  IF 28 PIN PART
INSTALL JP2  IF 40 PIN PART

Test Port

FOR USER"S MANUAL ONLY

A

SCHEMATIC, Z86L99 EMULATION DAUGHTER BOARD

B

4 11Tuesday, August 15, 2000

ICE MCU

Title

Size Document Number Rev

Date: Sheet of

XTAL2_T

XTAL1_I

A_Itv[15..8]

P5DA_I[0..7]

XTAL1tvXTAL1tv

XTAL1_I

XTAL2_T

L99Vref+

L99Vref-

AGND

R_W_Itv

P5DA_I0

P5DA_I2
P5DA_I3

P5DA_I6

P5DA_I1

P5DA_I5
P5DA_I4

R_W_Itv

nRST_Itv nRST_Itv

nMAS_Itv

nMDS_Itv
nIACKtv
nSYNCtv

nICEtv

XTAL1_TXTAL1_T

AD_Itv[7..0]

AD_Itv7
AD_Itv6
AD_Itv5
AD_Itv4
AD_Itv3
AD_Itv2
AD_Itv1
AD_Itv0

A_Itv15
A_Itv14
A_Itv13
A_Itv12
A_Itv11
A_Itv10
A_Itv9
A_Itv8

P5DA_I7 P4DA_I[0..7]

P4DA_I3
P4DA_I2

P4DA_I7

P4DA_I4

P4DA_I1
P4DA_I0

P4DA_I5
P4DA_I6

P2_I6
P2_I5

P2_I1

P2_I4

P2_I[0..7]

P2_I3
P2_I2

P2_I7

P2_I0

P6_I6
P6_I7

P6_I3
P6_I2

P6_I4

P6_I1

P6_I[0..7]

P6_I0

P6_I5

nDTMRtv
SCLKtv

AVDD

AD_Itv2
AD_Itv1

AD_Itv5

AD_Itv3

AD_Itv6
AD_Itv7

AD_Itv4

AD_Itv0

nXROFFtv

XTAL1_Tpg5

XTAL2_Tpg5

AGNDpg5

L99Vref-pg5

L99Vref+pg5

AVDDpg5

P4DA_I[0..7] pg5,7

P5DA_I[0..7] pg5,7

VCC_I

VCC_I

VCC_IVCC_I

VCC_I

VCC_IVCC_I

JP4

1
2

R46

10K

1
2

R42

10K

1
2

JP2

1
2

P7
1
3
5
7
9
11
13
15

2
4
6
8

10
12
14
16

JP3

1
2

J5

HDR103

1
2

3

JP1
CON2

12

R44

10K

1
2

R26

1M

1
2

R45

10K

1
2

C80
.01UF

R43

10K

1
2

+ C79

100uF

U17

Z86D99AA

31
34
59
60
61
62

4
6
3
9

10
18
19
21

23
63
15
64
71
65
77
66
73

74
78
79
80
81
5
7
8

82
83

1
44
45
46
47

55
35
38
39
40
49
54
50

67
68
72

56

16
17
20
22
57

24

14

43
30
29

33

32
76

11

28
27

84

70

75

42
41

25

13

26

2

12
36
37
51
5348

58

69
52

MA10
MA11
MA12
MA13
MA14
MA15

MAD0
MAD1
MAD2
MAD3
MAD4
MAD5
MAD6
MAD7

Vref+
nMAS
Vref-
nMDS
nIACK
nSYNC
SCLK
nDTIMER
nICE

P20
P21
P22
P23
P24
P25
P26
P27

P60
P61

P63
P64
P65
P66
P67

P50
P51
P52
P53
P54
P55
P56

P57a

P41
P42
P43

P40

P44
P45
P46
P47

R/nW

AVDD

AGND1

nRESET
XTAL1
XTAL2

VDD2

VSS2
VSS3

VDD1_CORE

MA9
MA8

P62

VSS4

VDD3

VSS5
VSS6

VDD4_CORE

VSS7

VDD5

VSS8

NC1
NC2
NC3
NC4
NC5DVBON

nICEIBF

AGND2
P57b

R27
10K

AD_Itv[7..0] pg11
A_Itv[15..8] pg11

P34tv pg11

nRST_Itv pg3,11

XTAL1tvpg11

R_W_Itvpg11

nAS_Itv pg11

nDS_Itv pg11

nXROFFtvpg11

P2_I[0..7] pg5,7

P6_I[0..7] pg5,7

nRST_Ttv pg11

nIACKtvpg11
nMDS_Itvpg11

nMAS_Itvpg11

nDTMRtvpg11

nSYNCtvpg11
SCLKtvpg11
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A

A

B

B

C

C

D

D

E

E

4 4

3 3

2 2

1 1

TARGE T CONNECTORS PLACE SWITCH IN OPEN
POSITION WHEN USING PORT
PIN FOR ANALOG FUN CTION.

TURN SWITCH TO ON POSIT ION
TO ENABL E RESISTOR PULL UP
ON PORT PINS.

TURN SWITCH TO ON POSI TION
TO ENAB LE RESISTOR PULL UP
ON PORT PINS.

TURN SWITCH TO ON POSI TION
TO ENAB LE RESISTOR PULL UP
ON PORT PINS.

TURN SWITCH TO ON POSI TION
TO ENAB LE RESISTOR PULL UP
ON PORT PINS.

(L99 PORT2)

(L99 PORT5)

(L99 PORT4)
(L99 PORT6)

IR LED OUTPUT

FOR USER"S MANUAL ONLY

A

SCHEMATIC, Z86L99 EMULATION DAUGHTER BOARD

B

5 11Tuesday, August 15, 2000

ICE MCU

Title

Size Document Number Rev

Date: Sheet of

P2PU_I0
P2PU_I1
P2PU_I2
P2PU_I3
P2PU_I4
P2PU_I5
P2PU_I6
P2PU_I7

P4PU_I1

P4PU_I7

P4PU_I5

P4PU_I2
P4PU_I3

P4PU_I0

P4PU_I4

P4PU_I6

AVDD

AGND

L99Vref+

L99Vref-

P2_I2

P2_I5

P2_I3

P4_I[0..7]
P2_I[0..7]

P4_I2
P4_I3

P5_I5 P5DA_I5

P2_I0

P4_I2 P4DA_I2

P2_I6

P5_I6 P5DA_I6

P2_I1

P4DA_I3P4_I3

P4_I6

P2_I4

P4_I6
P4_I5

P4_I5

P4_I0

P4_I7

P4_I4

P2_I7

P4_I4

P4_I1

P4_I7

P6_I6

VCC_Itar

P6_I4

P5DA_I2

P5DA_I5

P2_I4

P5DA_I1

P5DA_I7

GND

P2_I2

P4DA_I0

P6_I7

P6_I2

P6_I0

P5DA_I6

P6_I1

P4DA_I1

P5DA_I0

P2_I3

P2_I1

P5DA_I4

P2_I0

P4DA_I5

P6_I3

P2_I7

P2_I5

P2_I6

P4DA_I7

XTAL2_T

XTAL1_T

P5DA_I4P5_I4

P5DA_I3

P5DA_I7P5_I7

P6_I[0..7]

P6_I5

P4DA_I4

P4DA_I1P4_I1

P4DA_I6
P4DA_I2

P4DA_I0P4_I0

P5DA_I[0..7]

P5_I[0..7]

P2_I5

P2_I6
P2_I4

P2_I3
P2_I7

P4DA_I4
P2_I2

P2_I1
P4DA_I5

P4DA_I6
P2_I0

P4DA_J3
P4DA_I7

P3DA_I2

GND

P3DA_I1

P5DA_I0
P5DA_I1

XTAL1_T
P4DA_I0

P5DA_I6

GND

P5DA_I3
P5DA_I7

P5DA_I2

GND
P5DA_I5
P5DA_I4

VCC_Itar

XTAL2_T

P4DA_I3

P5_I4
P5_I3

P5_I1

P5_I5

P5_I7
P5_I6

P5_I0

P5_I2

P6_I6

P6_I0

P6_I7

P6_I1

P6_I5

P6_I2
P6_I3
P6_I4

P6PU_I0
P6PU_I1
P6PU_I2
P6PU_I3
P6PU_I4
P6PU_I5
P6PU_I6
P6PU_I7

P5PU_I1

P5PU_I7

P5PU_I0

P5PU_I6

P5PU_I3
P5PU_I2

P5PU_I5
P5PU_I4

P5_I1

P5_I3

P5_I0

P5_I2

P4DA_I5

P4DA_I7

P4DA_I4

P4DA_I6

P5DA_I3

P5DA_I1
P5DA_I2

P5DA_I0

P4DA_I[0..7]

P4DA_J3

AVDD pg4

AGND pg4

L99Vref+ pg4

L99Vref- pg4

P5DA_I[0..7] pg4,7

P4DA_I[0..7] pg4,7

XTAL1_T pg4

XTAL2_T pg4

XTAL2_T pg4

XTAL1_T pg4

VCC_I

VCC_I

VCC_I

VCC_Itar

VCC_Itar

VCC_I

VCC_Itar

S1

SW DIP-8

1
2
3
4
5
6
7
8

16
15
14
13
12
11
10
9

S4

SW DIP-8

1
2
3
4
5
6
7
8

16
15
14
13
12
11
10
9

P5

1
3
5
7
9
11
13
15
17
19
21
23
25
27
29
31
33
35
37
39
41
43
45
47
49
51
53
55
57
59
61
63

2
4
6
8

10
12
14
16
18
20
22
24
26
28
30
32
34
36
38
40
42
44
46
48
50
52
54
56
58
60
62
64

65
67
69
71
73
75
77
79

66
68
70
72
74
76
78
80

RN2 RES_BUS9_680K

2
3
4
5
6
7
8
9
10

1

S2

SW DIP-8

1
2
3
4
5
6
7
8

16
15
14
13
12
11
10
9

J7

CON2

1
2

RN1
RES_BUS9_680K

2
3
4
5
6
7
8
9
10

1

S5

SW DIP-8

1
2
3
4
5
6
7
8

16
15
14
13
12
11
10
9

RN3 RES_BUS9_680K

2
3
4
5
6
7
8
9
10

1

S6

SW DIP-8

1
2
3
4
5
6
7
8

16
15
14
13
12
11
10
9

RN4 RES_BUS9_680K

2
3
4
5
6
7
8
9
10

1

J8

CON2

1
2

P6

1
3
5
7
9
11
13
15
17
19
21
23
25
27
29
31
33
35
37
39
41
43
45
47
49
51
53
55
57
59

2
4
6
8

10
12
14
16
18
20
22
24
26
28
30
32
34
36
38
40
42
44
46
48
50
52
54
56
58
60

P4_I[0..7]pg4,7
P2_I[0..7]pg4,7

P6_I[0..7]pg4,7
P5_I[0..7]pg4,7
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A

A

B

B

C

C

D

D

E

E

4 4

3 3

2 2

1 1

ICE
MCU

P1_I[0..7] AD_Itv[7..0]

BUFFER
TRANSLATER
1

0-5V

MOTHERBOARD
INTERFACE

AD_I[7..0]
5V

BUFFER
TRANSLATER
3

TARGET
CONNECTOR

P1_M[0..7]
5V

P1_I[0..7]
0-5V

0-5V

L99 MODE:
- SET ROM_SIZE_RG = 16K.
- T3 IS TRI-STATED.
- WHEN DS_I IS ASSERTED:
  IF (FG/BG && OUTSIDE_ROM)
    TR-STATE T1.
  ELSE IF (FG/BG && !OUTSIDE_ROM)
    ENABLE T1.
  ELSE IF (!FG/BG)
    IF (C_JAM_P1)
      TRI-STATE T1.
    ELSE
      ENABLE T1.

NOTE: ZDS MUST NOT SET D_MEMFLAG REGISTER
      DMF_DATA BIT WHEN ACCESSING EXECUTABLE
      RAM.

T3

T1

A

SCHEMATIC, Z86L99 EMULATION DAUGHTER BOARD

B

6 11Monday, August 14, 2000

Title

Size Document Number Rev

Date: Sheet of
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A

A

B

B

C

C

D

D

E

E

4 4

3 3

2 2

1 1

SIGNAL BUFFER

SIGNA L
TRANSLATION

SIGNAL BUFFER

SIGNAL BUFFER

LOGIC ANALYZER  CONNECTOR

SIGNA L
TRANSLATION

(L99 PORT5)

(L99 PORT2)

(L99 PORT6)

(L99 PORT4)

FOR USER"S MANUAL ONLY
A

SCHEMATIC, Z86L99 EMULATION DAUGHTER BOARD

B

7 11Monday, August 14, 2000

LOGIC ANALYZER CONNECTOR

Title

Size Document Number Rev

Date: Sheet of

AD_I0
AD_I1
AD_I2
AD_I3
AD_I4
AD_I5
AD_I6
AD_I7
A_I8
A_I9
A_I10
A_I11
A_I12
A_I13
A_I14
A_I15

P2_I[0..7]

P6_I[0..7]

P2_I0
P2_I1
P2_I2
P2_I3
P2_I4
P2_I5
P2_I6
P2_I7
P6_I0
P6_I1
P6_I2
P6_I3
P6_I4
P6_I5
P6_I6
P6_I7

P64

P66

P63
P62

P24

P26
P25

P60
P27

P20

P61

P21

P67

P23
P22

P65

A_I[15..8]

AD_I[7..0]

nMAS

P_CT_CLK

LG_nPGM

AD_M[7..0]

AD_M7

P_CLK

nP_PGM

AD_M2

AD_M5

P_TBD1

P_CLK_CE

P_CLR

AD_M6

AD_M4
AD_M3

P_TBD2

AD_M0
AD_M1

P_WR_RDLG_WR_RD

LG_AD_M0

MAD3

LG_AD_M7

MAD2

LG_AD_M6

LG_AD_M4
LG_AD_M3

MAD5

LG_AD_M1

MAD0

LG_AD_M5

MAD1

MAD4

LG_AD_M2

MAD7
MAD6

MAD[7..0]

P67

LG_AD_M4

MAD0

P60

P22

LG_PTBD1

MAD5

P21

P24
P27

MAD1
MAD3

P20

LG_FG_BG

LG_P_CLR

P62 P63

P25

P64

MAD2

GND

LG_AD_M0

MAD4

P61

LG_AD_M6
LG_AD_M5

LG_WR_RD

P26

LG_PTBD2

GND

MAD7

P66

LG_AD_M3

P23

LG_AD_M2

P65

LG_AD_M7

GND

LG_AD_M1

MAD6

GND

LG_SCLK

MA8
MA9

MA12
MA11

MA10

MA13

MA13

MA9

MA10

MA15MA14

MA11
MA8

MA12

MA15
MA14

MA[15..8]

nMAS
LG_32_64

R32_64

SCLK
FG_BG

nRST_frI

nIRQ_ACK
nSYNC

R_W_I

nMDS_I

nMAS_I

nDS_I

nAS_I
LG_32_64

R_W

R_W

nDS

nDS

nMDS

nMDS

nLG_SYNC

nLG_SYNC

nLG_IACK

nLG_IACK
LG_FG_BG
LG_SCLK

nAS

nAS

nRESET

nRESET

LG_CTCLK

LG_CTCLK

LG_PTBD2

LG_P_CLK

LG_P_CLK

LG_nPGM
LG_CLKCE

LG_CLKCE

LG_PTBD1

LG_P_CLR

P2[0..7]
P6[0..7]

LG_SCLK

P2[0..7]
GND

P40

P52

P4_I7 P47

P57

P45

P55

P5_I0

P47

P54

P52

P42

P56

P5_I1

P5_I5

P42

P4_I6

P46

P46

P51

P43

P4_I2
P43

P56

P53

P44

P40

P51

P41

P53

P57

P44

P50

P4_I4

P5_I3

P41

P4_I3

P5_I4

P5_I2

P4_I1

P4_I5

P5_I7

P55

P5_I6

P4_I0

P5[0..7] P5[0..7]

P45

P54

P50

LG_AD_M[7..0]
P4[0..7] P4[0..7]

P4_I[0..7]

P5_I[0..7]

LG_nXROF

LG_nXROF nEXR_OFF

P_TBD3LG_PTBD3

LG_PTBD3

VCC_I
VCC

VCC

VCC

VCC

VCC

VCC

VCC_I

VCC

U10

IDT74FCT164245TPA

48

47

1

46

25

44

24

43
41
40
38
37
36
35
33
32
30
29
27
26

2
3
5
6
8
9
11
12
13
14
16
17
19
20
22
23

7
18
31
42

4
10
15
21

28
34
39
45

1OE

1A1

1DIR

1A2

2OE

1A3

2DIR

1A4
1A5
1A6
1A7
1A8
2A1
2A2
2A3
2A4
2A5
2A6
2A7
2A8

1B1
1B2
1B3
1B4
1B5
1B6
1B7
1B8
2B1
2B2
2B3
2B4
2B5
2B6
2B7
2B8

VCCB1
VCCB2
VCCA1
VCCA2

GND4
GND10
GND15
GND21

GND28
GND34
GND39
GND45

R29

10K

U12

IDT74FCT164245TPA

48

47

1

46

25

44

24

43
41
40
38
37
36
35
33
32
30
29
27
26

2
3
5
6
8
9
11
12
13
14
16
17
19
20
22
23

7
18
31
42

4
10
15
21

28
34
39
45

1OE

1A1

1DIR

1A2

2OE

1A3

2DIR

1A4
1A5
1A6
1A7
1A8
2A1
2A2
2A3
2A4
2A5
2A6
2A7
2A8

1B1
1B2
1B3
1B4
1B5
1B6
1B7
1B8
2B1
2B2
2B3
2B4
2B5
2B6
2B7
2B8

VCCB1
VCCB2
VCCA1
VCCA2

GND4
GND10
GND15
GND21

GND28
GND34
GND39
GND45

U9

IDT74FCT16244ATPA

48

47

1

46

25

44

24

43
41
40
38
37
36
35
33
32
30
29
27
26

2
3
5
6
8
9

11
12
13
14
16
17
19
20
22
23

7
18
31
42

4
10
15
21

28
34
39
45

2OE

1A1

1OE

1A2

3OE

1A3

4OE

1A4
2A1
2A2
2A3
2A4
3A1
3A2
3A3
3A4
4A1
4A2
4A3
4A4

1Y1
1Y2
1Y3
1Y4
2Y1
2Y2
2Y3
2Y4
3Y1
3Y2
3Y3
3Y4
4Y1
4Y2
4Y3
4Y4

VCC7
VCC18
VCC31
VCC42

GND4
GND10
GND15
GND21

GND28
GND34
GND39
GND45

U8

IDT74FCT16244ATPA

48

47

1

46

25

44

24

43
41
40
38
37
36
35
33
32
30
29
27
26

2
3
5
6
8
9
11
12
13
14
16
17
19
20
22
23

7
18
31
42

4
10
15
21

28
34
39
45

2OE

1A1

1OE

1A2

3OE

1A3

4OE

1A4
2A1
2A2
2A3
2A4
3A1
3A2
3A3
3A4
4A1
4A2
4A3
4A4

1Y1
1Y2
1Y3
1Y4
2Y1
2Y2
2Y3
2Y4
3Y1
3Y2
3Y3
3Y4
4Y1
4Y2
4Y3
4Y4

VCC7
VCC18
VCC31
VCC42

GND4
GND10
GND15
GND21

GND28
GND34
GND39
GND45

U11

IDT74FCT16244ATPA

48

47

1

46

25

44

24

43
41
40
38
37
36
35
33
32
30
29
27
26

2
3
5
6
8
9

11
12
13
14
16
17
19
20
22
23

7
18
31
42

4
10
15
21

28
34
39
45

2OE

1A1

1OE

1A2

3OE

1A3

4OE

1A4
2A1
2A2
2A3
2A4
3A1
3A2
3A3
3A4
4A1
4A2
4A3
4A4

1Y1
1Y2
1Y3
1Y4
2Y1
2Y2
2Y3
2Y4
3Y1
3Y2
3Y3
3Y4
4Y1
4Y2
4Y3
4Y4

VCC7
VCC18
VCC31
VCC42

GND4
GND10
GND15
GND21

GND28
GND34
GND39
GND45

P3
1
3
5
7
9

11
13
15
17
19
21
23
25
27
29
31
33
35
37
39
41
43
45
47
49
51
53
55
57
59
61
63
65
67
69
71
73
75
77
79
81
83
85
87
89
91
93
95
97
99

2
4
6
8
10
12
14
16
18
20
22
24
26
28
30
32
34
36
38
40
42
44
46
48
50
52
54
56
58
60
62
64
66
68
70
72
74
76
78
80
82
84
86
88
90
92
94
96
98
100

P2_I[0..7]pg4,5

P6_I[0..7]pg4,5

A_I[15..8]pg11

AD_I[7..0]pg8,11

P_CT_CLK pg8

P_WR_RD pg3
nP_PGM pg3

P_CLK_CE pg3

P_TBD2 pg3

P_CLR pg3

AD_M[7..0] pg8

P_CLK pg3
P_TBD1 pg3

R32_64 pg3

SCLK pg11
FG_BG pg8

nRST_frI pg11

nIRQ_ACK pg11
nSYNC pg11

R_W_I pg11

nMDS_I pg11

nMAS_I pg11

nDS_I pg11

nAS_I pg11

P2[0..7] pg8

P4[0..7] pg8
P5[0..7] pg8

P5_I[0..7]pg4,5

P4_I[0..7]pg4,5

nEXR_OFF pg3,11

P_TBD3 pg3
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A

A

B

B

C

C

D

D

E

E

4 4

3 3

2 2

1 1

(nIACK)
(nCS_U245)

(nU_AS)

(U_PXX)

(U_P10)
(U_P11)
(U_P12)
(U_P13)
(U_P14)
(U_P15)
(U_P16)
(U_P17)
(U_P40)
(U_P41)
(U_P42)
(U_P43)
(U_P44)
(U_P45)
(U_P46)
(U_P47)
(U_P20)
(U_P21)
(U_P22)
(U_P23)
(U_P24)
(U_P25)
(U_P26)
(U_P27)

(ICRAM)
(UD0)
(UD1)
(UD2)
(UD3)
(UD4)
(UD5)
(UD6)
(UD7)

(U_P50)
(U_P51)
(U_P52)
(U_P53)
(U_P54)
(U_P55)
(U_P56)
(U_P57)

(UA8)
(UA9)
(UA10)
(UA11)
(UA12)
(UA13)
(UA14)
(UA15)

(SIZE0)
(SIZE1)
(SIZE2)
(SIZE3)
(SIZE4)

(M_A8)
(M_A9)
(M_A10)

(M_A12)
(M_A13)
(M_A14)
(M_A15)

(M_A11)

(M_P31)

(nCS_RD)
(nD_E)
(6D0X=>6D0X)
(6D2X=>6D1X)
(6D4X=>6D2X)
(6D6X=>6D3X)
(6D8X=>6D4X)
(6DAX=>6D5X)

(57FX=>6D7X)(57EX=>6D6X)
(nBRPDRAM)
(nBRP_OFF)

(nBRPPRAM)
(nBRP_ROM)

(CH_DIR)

(D0)
(D1)
(D2)
(D3)
(D4)
(D5)
(D6)
(D7)

(M_D0)
(M_D1)
(M_D2)
(M_D3)
(M_D4)
(M_D5)
(M_D6)
(M_D7)

P_BUF_WR_CLK
LED_CLK

(TRIGGER)
(M_P25)

(TRACE)

(14V)

(nU_M_DS)

(nM_AS)
(nM_DS)
(M_R/W)

(nRESET2)

(nCS)
(VPP)
(EPM)

(VCC_CT)

(P_TBD0)
(P_TBD1)
(P_TBD2)

(P_TBD3)

MB INTER FACE CONNECTOR 1

MB INTER FACE CONNECTOR 2

(U_P35)
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A
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B
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MOTHERBOARD INTERFACE

Title

Size Document Number Rev

Date: Sheet of

nIRQ_ACK

SCLK
nSYNC

C_JAM_P1
nMAS_I

FG_BG

AD_I4
AD_I3
AD_I2

AD_I0
AD_I1

AD_I5
AD_I6
AD_I7

AD_I[7..0]

nRST_CT

nDS_frI

nRST_frM

C_DR_ADI

nWR_DAC

AD_M0
AD_M1
AD_M2
AD_M3
AD_M4

AD_M7
D_P0
D_P1
D_P2
D_P3

D_P7
D_P6

D_P4
D_P5

nAS_M

AD_M6
AD_M5

D_P[7..0]

AD_M[7..0]

P_CT_CLK

nDS_M

A_M8
A_M9
A_M10
A_M11
A_M12
A_M13
A_M14
A_M15

A_M[15..8]

P_AL_CLK

R_W_I

R_W_M

P_WR_RD
P_CLK_CE

P_AH_CLK

nDM

nDM

P50
P51
P52
P53
P54
P55
P56
P57

P40
P41
P42
P43
P44
P45
P46
P47
P20
P21
P22
P23
P24
P25
P26
P27

A_I13

A_I15

A_I[15..8]

A_I8

A_I12

A_I14

A_I11
A_I10
A_I9

VCCVCC

P2
1
3
5
7
9

11
13
15
17
19
21
23
25
27
29
31
33
35
37
39
41
43
45
47
49
51
53
55
57
59
61
63

2
4
6
8
10
12
14
16
18
20
22
24
26
28
30
32
34
36
38
40
42
44
46
48
50
52
54
56
58
60
62
64

P1
1
3
5
7
9

11
13
15
17
19
21
23
25
27
29
31
33
35
37
39
41
43
45
47
49
51
53
55
57
59
61
63

2
4
6
8
10
12
14
16
18
20
22
24
26
28
30
32
34
36
38
40
42
44
46
48
50
52
54
56
58
60
62
64

D_P[7..0]pg10

P_WR_RDpg3

nWR_DACpg9

nDS_frIpg3

nRST_frMpg3

nAS_Mpg3

C_DR_ADIpg3

nRST_CTpg3

nIRQ_ACK pg11

nMAS_I pg11
C_JAM_P1 pg3

nSYNC pg11
SCLK pg11

FG_BG pg3,7,11
AD_I[7..0] pg7,11

A_I[15..8] pg11

P_CLK_CEpg3

nDS_Mpg3
AD_M[7..0]pg3,7,9,10

A_M[15..8]pg3

P_AL_CLKpg10

R_W_Mpg3

R_W_I pg11

P_AH_CLKpg10

P_CT_CLKpg3,7

nDM pg3

P5[0..7] pg7

P4[0..7] pg7

P2[0..7] pg7
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A

A

B

B

C

C

D

D

E

E

4 4
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1 1

15V OUTP UT ISR

DAC IC

2.5V REFERE NCE

POWER OP-AMP
CIRC UIT

(0-14V)

(0-14V)

(0-14V)

(0 - 5.0V)

2V - 4V
Adjustable
Power

LAYO UT NOTE: 
USE THICK TRACES FOR THESE POWER
SOURCES.

USER NOTE:
SELECT VO LTAGE SOURCE FOR EMULATION SYSTEM.

4) ICE = VCC_lint  TARGET = VCC_lint  5-7 , 6-8

2) ICE = VCC_reg TARGET = VCC_reg  1-3 , 2-4
3) ICE = VCC_lint  5-7

5) ICE = VCC_reg  TARGET = VCC_lint  1-3 , 6-8

1) ICE = VCC_reg 1-3

7) ICE = TARGET  3-4
6) ICE = VCC_lint  TARGET = VCC_reg  5-7 , 2-4
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POWER LOGIC

Title

Size Document Number Rev

Date: Sheet of

VCC_VPP

VCC_VV

DAC_V1

DAC_V2

DAC_V0

nWR_DAC

DAC_V3

VCC_Iint

AD_M5

AD_M7

AD_M4

AD_M1
AD_M2

AD_M0

AD_M3

AD_M6

A_M_LO0

DAC_VREF

A_M_LO1

AD_M[7..0]

A_M_LO[1..0]

VCC_EPM

VCC_15V

VCC_15V

VCC_15V

VCC_15V

VCC

VCC_15V

VCC_VPP

VCC

VCC_VV

VCC

VCC_Iint

VCC_reg

VCC_regVCC_reg
VCC_I
VCC_I

VCC_IintVCC_Iint

VCC_Itar
VCC_Itar

VCC_EPM

C1

1UF

R12

2K_1%

C2

1UF

R9

2K_1%

R11

10K_1%

R10

2K_1%

R30

121

R31

73.2

R32

200

R2

2K_1% R4

2K_1%

U6

MAX506

14
13
12
11
10
9
8
7

17
16

15

2

1

20

19

18
3
6
5
4

D0
D1
D2
D3
D4
D5
D6
D7

A0
A1

WR

VOUTA

VOUTB

VOUTC

VOUTD

VDD
VSS

DGND
AGND
VREF

+

-

U5A

LT1014DS

3

2
1

4
13

R3

10K_1%

+ C73
10uF C75

0.1UF

+ C3
100uF16V

C4

0.1UF

R40 200 1W

+ C74
22uF

+

-

U5B

LT1014DS

5

6
7

4
13

C7

0.1UF

+ C76
22uF

R16

2K_1%

R41 500R13

2K_1%

U19
LT1086CM

3
1

2VIN
A

D
J

VOUT

R5

2K_1%

C5

0.1UF

R15

2K_1%

C6

0.1UF

R8

2K_1%

U7

MC1403D

1

3

2
6
7

4
5

8

Vin

GND

Vo_2.5
NC3
NC4

NC1
NC2

NC5

U4

PT5042
1 3

2

VIN VOUT

G
N

D

+

-

U5D

LT1014DS

14

15
16

4
13

J6

CON8A

1
3
5
7

2
4
6
8

R6

2K_1%

R1

2K_1%

R7

10K_1%

+

-

U5C

LT1014DS

12

11
10

4
13

Q4

FZT849
1

3
2

R14

2K_1%

nWR_DACpg8

AD_M[7..0]pg8

A_M_LO[1..0]pg3
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A

B

B
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D

D

E
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HEADERS  FOR OTP
PROGRAMMING SOCKET
ADAPTERHIGH TO LOW & LOW TO HIGH

VOLTAGE TRANSLATION

CONTROL SIGNAL FOR OTP
PROGRAMM ING

HEADERS  FOR OTP
PROGRAMMING SOCKET
ADAPTER

HIGH TO LOW VOLT AGE TRANSLATION OTP REGI STER FOR MSB
& LSB OF ADD RESS
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PROGRAMMING LOGIC

Title

Size Document Number Rev

Date: Sheet of

D_Ptv4
D_Ptv6

D_Ptv0
D_Ptv2

D_Ptv7
D_Ptv5

D_Ptv1
D_Ptv3

nP_tvCE

P_tvCLK P_tvCLK

D_Ptv4
D_P5 D_Ptv5
D_P4

D_Ptv3

D_Ptv6
D_Ptv7

D_Ptv0
D_Ptv1
D_Ptv2

D_P0
D_P1

D_P6
D_P7

P_RD_WR

D_Ptv[7..0]

nP_tvOE

D_P3
D_P2

D_P[7..0]

P_TBD1

P_CLR

P_TBD2

nP_PGM

P_CLK

P_WR_RD

P_TBD3

A_Ptv[15..0] AD_M[7..0]

A_Ptv2

A_Ptv11

A_Ptv4

A_Ptv9

A_Ptv1

A_Ptv4
A_Ptv6

A_Ptv14

A_Ptv0

A_Ptv15

A_Ptv8

A_Ptv2

A_Ptv0

A_Ptv13

A_Ptv3

A_Ptv14

A_Ptv10

A_Ptv1

A_Ptv12
A_Ptv10

A_Ptv8

A_Ptv6

A_Ptv12

A_Ptv5

A_Ptv3

A_Ptv13
A_Ptv11

A_Ptv5
A_Ptv7

A_Ptv15

A_Ptv9A_Ptv7 A_P9

P_CLK_CE

AD_M3

AD_M5

P_AH_CLK

AD_M2

AD_M7

A_P5

AD_M6

A_P7

A_P1
A_P0 AD_M0

A_P12

AD_M1

A_P13

A_P3
A_P4

AD_M4

A_P10

A_P6

AD_M4

P_CLK_CE

AD_M2

A_P11

A_P2

AD_M7

AD_M1

A_P15

AD_M3

A_P8

P_AL_CLK

A_P14
AD_M5

AD_M0

AD_M6

nP_tvPGM

nP_tvCE
nP_tvOE
nP_tvPGM

P_tvTBD1

P_tvTBD1

P_tvCLR P_tvCLR

P_tvTBD2 P_tvTBD2

P_CLK_CE

P_tvTBD3P_tvTBD3

VCC_I

VCC

VCC_I

VCC_VPP

VCCVCC_VV
VCC_EPM

VCC_I

J1

HDR15X2

1 2
3 4
5 6
7 8
9 10

11 12
13 14
15 16
17 18
19 20
21 22
23 24
25 26
27 28
29 30

U1

IDT74FCT164245TPA

48

47

1

46

25

44

24

43
41
40
38
37
36
35
33
32
30
29
27
26

2
3
5
6
8
9

11
12
13
14
16
17
19
20
22
23

7
18
31
42

4
10
15
21

28
34
39
45

1OE

1A1

1DIR

1A2

2OE

1A3

2DIR

1A4
1A5
1A6
1A7
1A8
2A1
2A2
2A3
2A4
2A5
2A6
2A7
2A8

1B1
1B2
1B3
1B4
1B5
1B6
1B7
1B8
2B1
2B2
2B3
2B4
2B5
2B6
2B7
2B8

VCCB1
VCCB2
VCCA1
VCCA2

GND4
GND10
GND15
GND21

GND28
GND34
GND39
GND45

U3

IDT74FCT162374ATPV

47
46
44
43
41
40
38
37
36
35
33
32
30
29
27
26

2
3
5
6
8
9

11
12
13
14
16
17
19
20
22
23

48
1
25
24

7
18
31
42

4
10
15
21

28
34
39
45

1D1
1D2
1D3
1D4
1D5
1D6
1D7
1D8
2D1
2D2
2D3
2D4
2D5
2D6
2D7
2D8

1O1
1O2
1O3
1O4
1O5
1O6
1O7
1O8
2O1
2O2
2O3
2O4
2O5
2O6
2O7
2O8

1CLK
1OE

2CLK
2OE

VCC7
VCC18
VCC31
VCC42

GND4
GND10
GND15
GND21

GND28
GND34
GND39
GND45

J2

HDR15X2

1 2
3 4
5 6
7 8
9 10

11 12
13 14
15 16
17 18
19 20
21 22
23 24
25 26
27 28
29 30

U2

IDT74FCT164245TPA

48

47

1

46

25

44

24

43
41
40
38
37
36
35
33
32
30
29
27
26

2
3
5
6
8
9
11
12
13
14
16
17
19
20
22
23

7
18
31
42

4
10
15
21

28
34
39
45

1OE

1A1

1DIR

1A2

2OE

1A3

2DIR

1A4
1A5
1A6
1A7
1A8
2A1
2A2
2A3
2A4
2A5
2A6
2A7
2A8

1B1
1B2
1B3
1B4
1B5
1B6
1B7
1B8
2B1
2B2
2B3
2B4
2B5
2B6
2B7
2B8

VCCB1
VCCB2
VCCA1
VCCA2

GND4
GND10
GND15
GND21

GND28
GND34
GND39
GND45

P_RD_WRpg3

D_P[7..0]pg8

P_CLK_CEpg3
P_WR_RDpg3

nP_PGMpg3
P_CLRpg3
P_CLKpg3

P_TBD1pg3
P_TBD2pg3

P_AL_CLK pg8

AD_M[7..0] pg8

P_AH_CLK pg8

P_TBD3pg3
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A

B

B
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D

D

E

E
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LOW TO HIGH VOLT AGE TRANSLATION

LOW TO HIGH VOLT AGE TRANSLATION

SOCKET F OR ICE
MCU
OSCILLATO R
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VOLTAGE TRANSLATOR

Title

Size Document Number Rev

Date: Sheet of

nAS_I

P34tv

nDS_Itv
nMDS_I

nMAS_Itv

nDS_I
R_W_I

nRST_T

R_W_Itv

P34_nDM
nMAS_I

nRST_Ttv
nMDS_Itv

nRST_frI
nIRQ_ACK

XTAL1_EM
XTAL1tv

nDTMRtv

AD_Itv4
AD_I5

AD_I1

AD_Itv3

AD_Itv0

AD_I6

A_Itv12

AD_I4

A_Itv11
A_I12

AD_Itv6

AD_Itv1

AD_Itv7

AD_Itv5

A_I[15..8]

AD_Itv2

A_Itv15
AD_I0

A_I14A_Itv14

A_Itv8

AD_I[7..0]

AD_Itv[7..0]

A_I10

A_I8

A_Itv10

A_Itv[15..8]

AD_I2

A_I15

A_Itv13

AD_I7

A_I11

A_I13

A_Itv9

AD_I3

A_I9

I_WR_RD
nAD_I_OE

FG_BG

nRST_Itv

nSYNCtv

nAS_Itv
SCLKtv

nIACKtv

nSYNC
SCLK

nXROFFtv nEXR_OFF

VCC
VCC

VCC_I

VCC_I

VCC

VCC_I

VCCVCC

VCC_I

U14B

74LVC08A

4

5
6

R24 10K

U16

IDT74FCT164245TPA

48

47

1

46

25

44

24

43
41
40
38
37
36
35
33
32
30
29
27
26

2
3
5
6
8
9
11
12
13
14
16
17
19
20
22
23

7
18
31
42

4
10
15
21

28
34
39
45

1OE

1A1

1DIR

1A2

2OE

1A3

2DIR

1A4
1A5
1A6
1A7
1A8
2A1
2A2
2A3
2A4
2A5
2A6
2A7
2A8

1B1
1B2
1B3
1B4
1B5
1B6
1B7
1B8
2B1
2B2
2B3
2B4
2B5
2B6
2B7
2B8

VCCB1
VCCB2
VCCA1
VCCA2

GND4
GND10
GND15
GND21

GND28
GND34
GND39
GND45

U15

IDT74FCT164245TPA

48

47

1

46

25

44

24

43
41
40
38
37
36
35
33
32
30
29
27
26

2
3
5
6
8
9
11
12
13
14
16
17
19
20
22
23

7
18
31
42

4
10
15
21

28
34
39
45

1OE

1A1

1DIR

1A2

2OE

1A3

2DIR

1A4
1A5
1A6
1A7
1A8
2A1
2A2
2A3
2A4
2A5
2A6
2A7
2A8

1B1
1B2
1B3
1B4
1B5
1B6
1B7
1B8
2B1
2B2
2B3
2B4
2B5
2B6
2B7
2B8

VCCB1
VCCB2
VCCA1
VCCA2

GND4
GND10
GND15
GND21

GND28
GND34
GND39
GND45

U14C

74LVC08A

9

10
8

Y1

8MHZ_FS

1 14

87

54

NC VCC

OUT2GND2

OUT1GND1

U14D

74LVC08A

12

13
11

U14A

74LVC08A

1

2
3

A_Itv[15..8]pg4

FG_BG pg8

AD_I[7..0]pg7,8

nRST_Ttvpg4

P34_nDMpg3

nRST_Tpg3
nMDS_Ipg3,7

nMDS_Itvpg4
nDS_Itvpg4

nDS_Ipg3,7

nAS_Ipg3,7

R_W_Ipg3,7,8

nMAS_Itvpg4
R_W_Itvpg4

nMAS_Ipg3,7,8

P34tvpg4

SCLKpg3,7,8

nRST_frIpg3,7
nIRQ_ACKpg7,8

nDTMRtv pg4

XTAL1tv pg4

AD_Itv[7..0]pg4

A_I[15..8]pg3,7,8

I_WR_RDpg3
nAD_I_OEpg3

nRST_Itvpg3,4
nAS_Itvpg4

nSYNCtvpg4

nIACKtvpg4

SCLKtvpg4

nSYNCpg3,7,8

nEXR_OFF pg7nXROFFtvpg4

UM005100-IRR0400                                                                                                                Schematic 11


